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Overview 

What is NEO Email Finder 

Stop Searching, Start Finding Your Emails 

Happy with Outlook but struggling to find your older emails back? 

Stop searching and start finding your emails with NEO Email Finder. As a companion product 
of Outlook NEO Find runs unnoticed in the background keeping track of every move as email 
arrives, goes out and is stored away in your filing system. 

NEO FIND organizes all emails automatically in the most logical and intuitive way people 
think about their messages: around the correspondent involved in the email communication. 
Just enter (part of) the name of the Correspondent and all emails are available, both sent 
and received. 

Advanced filtering combined with a lightning fast search facility will bring up every email 
within seconds to your attention – independent where they are located in your entire Outlook 
system or how complex your filing system may be.  

Finding messages is a breeze 

Your messages automatically appear exactly where you would expect them: at the 
Correspondent who was involved in the conversation. That makes finding them completely 
intuitive: no more need to search your emails as they are right where they should be. And 
when you do need to add a little search, our patented search technology is lightning fast. 

The only tool NOT searching for your emails  

NEO Find: The only tool available which is not searching for your emails, but is automatically 
organizing them so you can find your emails where you expect them to be 

Companion product for Microsoft Outlook 

NEO Email Finder is a companion product for Microsoft Outlook 97, 98, 2000, 2002(XP), 
2003 and 2007. It works with Exchange, POP3 and IMAP message stores linked to Outlook.   

How NEO Works with Microsoft Outlook 

NEO is an add-on product to Microsoft Outlook and works with Outlook 97, 98, 2000, 2002, 
2003, 2007 and Exchange Servers 5.5, 2000, 2003 and 2007. 

A single Catalog for all your Outlook message stores 

Within Outlook you will normally want to keep multiple message stores: your mailbox for 
arriving messages, your filing system and probable one or more archive message stores. 
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NEO Find will create a single Catalog, holding references to all your emails throughout the 
entire Outlook system. 

Your email messages are only indexed and not duplicated in NEO – the messages remain 
stored in your Outlook or Exchange Server message stores. 

Like Outlook, NEO interfaces with your underlying message stores. When messages arrive 
into your message store, NEO is notified. When you send or delete messages, your NEO 
Catalog is updated in exactly the same way. 

Indexing and the Catalog 

NEO works by creating indexes to your messages and storing the indexes in a separate 
NEO catalog. Whenever messages are sent, received or updated in the message store, NEO 
automatically updates the indexes in the catalog.  

In NEO Find you can add all your message stores to become completely independent of the 
exact storage location within Outlook. 

How NEO works with Exchange Server 

NEO Find works with Microsoft Exchange Server mailboxes. 

Here are some notes about using NEO Find with Exchange Server: 

NEO is a client-side product 

That means NEO installs and operates completely on your computer. There is nothing about 
NEO that gets installed on the server or that is related to Exchange Server. In fact, Exchange 
Server is completely unaware of NEO. 

You can organize your Mailbox, your PSTs and IMAP message stores 

If you are using NEO Find you can include your mailbox and as many PSTs or IMAP 
message stores as you like in your catalog. NEO Find will give you a seamless view to all 
your messages. NEO Find makes it appear as though all your emails are in one single 
location. 

Using your offline message store (OST) 

Using Offline mode or Cached Exchange Mode will not affect organization of your messages 
within NEO Find. You can work as you always have while NEO Find keeps perfect track of 
every move.     



Page | 9   

Getting Started 

Ways to start NEO  

It's best to start NEO Find when Outlook starts and keep it running 

It is recommended to start NEO Find when starting Outlook. You can configure NEO Find to 
start when Outlook is started under Tools | Options | General tab. When you keep NEO Find 
running with Outlook, it keeps track of all message coming in/going out while running 
unnoticed in the background. When looking for a message you are always sure NEO Find is 
fully in sync with Outlook. 

NEO Find and the system tray 

When minimizing NEO Find, it will hide in the system tray (the area where also the computer 
clock is located). Clicking the NEO Find icon will open and bring NEO Find to the foreground 
ready to find your messages.  

You can configure NEO Find to minimize and hide in the system tray when starting setting 
this option in Tools | Options. This way NEO Find will never be in your way when started 
automatically by Outlook. 

Right-clicking the NEO Find icon in the System Tray opens a small menu with following 
options:  

 

“Options” will open NEO Find with the Options menu open (from the Tools menu). 

 

“Open Outlook” will open Outlook, even when Outlook has not started in the 
foreground or when Outlook was already closed. 

 

“Open NEO Find” (default) opens NEO Find. 

 

“Exit” will close down NEO Find without first opening it in the foreground. 

Start NEO manually 

After Outlook has started, you can also start NEO manually as you would any application: 

 

Click NEO Find from Start | Programs. 

 

Double-click the NEO Find icon on your desktop 

You can also start NEO Find from Outlook: Click Go to NEO Find on the Tools menu in 
Outlook, or click the NEO Find icon on the Outlook toolbar. 
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Closing NEO  

Closing NEO Find automatically with Outlook 

Closing Outlook through the File | Exit command will automatically close NEO Find as well. 
By customizing Outlook's toolbar the File | Exit command can be placed anywhere on the 
toolbar (e.g. to the right of the Help command). This will provide easy access and a single 
click to close both Outlook and NEO Find. For further details please refer to our Knowledge 
Base article T1181.  
Please keep in mind when closing Outlook's window (through the top right 'X'), Outlook's 
process is allowed to continue to run which will not force a close-down of NEO Find. 

Get help from within NEO  

Help is available from within NEO via: 

Tool tips         For a short description of toolbar commands and other command buttons, 
roll your mouse over the command. A tool tip will appear in about one 
second. 

Shortcuts       Available on the Help menu.  

Help system   Press F1; also available through "more info" and Help buttons inside NEO.  

Support and Feedback 

Click Send Email to Support on the Help menu.   
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Finding Emails 

A short introduction to NEO Find 

NEO Find’s main features.  

   View tabs  

All your emails are automatically organized 
into Correspondent folders for you.  

Enter your search words and NEO 
automatically searches across all your 
folders.  

You can view your Outlook folders just as in 
Outlook.  

   How NEO Find works   

NEO Find organizes all your emails automatically using Virtual Folders. 

No need to search for your emails as you know exactly where they are!   

Virtual 
Folders 

NEO displays the same message automatically for every 
Correspondent involved in the correspondence:      
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Finding Messages Quickly 

Use the Correspondent to find all your messages  

F5 

Click the Find Correspondent button on the toolbar 
(F5). If looking for Fiona Mackay, enter mac in the 
Folder List filter to short-list your Corresondents for 
easy selection.  

  

The green 
background color 
tells you that you 
have a Folder List 
filter active. 

To clear the filter, 
click Clear or press 
the Esc key. 

Search within a Correspondent folder  

F6 

Highlight a Correspondent and click the Search in 
(Correspondent) Folder button (F6) to quickly 
search through the mails from a single 
correspondent. 

    



Page | 13   

Search on Conversation  

F7 

Highlight a message (e.g,. with Subject Product 
Ideas) then click the Search on Conversation 
button (F7) to find all messages in the same 
conversation. 

 

Free Search  

F8 

Click the New Search button on the toolbar (F8) to 
do a full search through the entire Outlook system 
producing lightning fast results.    

You can even 
enter logical 
phrases like (car 
or bus) near 
accident. 

Or enter 
parameters to limit 
your search such 
as searching within 
a folder.   

Jump to containing folder(s)  

Right-click any message and choose Jump to 
Folder (Ctrl+J) to display all messages for the person 
from the email, in this case, Terry Johnston.  
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Options & Customizing   

Your Addresses 

About Your Addresses 

NEO needs to know which addresses are yours in order to automatically organize your 
messages. If not all your addresses are entered, your messages will not appear correctly. 

Note that NEO must know all your addresses - not just your currently used ones. Be sure 
to include your old addresses if you have messages that used them. 

Auto-detecting your addresses on catalog creation 

NEO automatically detects your addresses when you create a catalog, and you can add to 
the list NEO auto-detects. Addresses you enter are displayed in bold. 

Important Note:      NEO does not auto-detect addresses you use after creating the catalog. You 
have to enter these manually. 

Adding and removing addresses 

You can add addresses and you can remove addresses you add. Addresses NEO auto-
detects cannot be removed - however, you can choose not to include them by unchecking 
them). 

Click File menu | Your Addresses to keep your addresses up to date. 
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To add an address, click the Add command. POP3 email addresses are entered in the usual 
way (e.g., bcoopersmith@fbi_NY.com). Exchange Server addresses are entered in X.500 
format. 

Options 

 

General Options 

These options control NEO startup and other general settings. 
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Reading Pane Options 

These options relate to the Reading Pane.      
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Formatting Options 

These options set how items are formatted. 
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Miscellaneous options 

In this tab additional options can be set as described below.     

Other Ways to Customize 

  

Resizing the Reading Pane 

The Reading Pane can be positioned either at the bottom or to the right of the screen. This 
can be defined on View menu. Size of the Reading Pane can be changed to any desired size 
by dragging the pane separator to a new location. Switching off the Reading Pane is done 
through the View menu. 

Note that you don't have to see the List Pane messages in order to read them in the Reading 
Pane. You can use the following shortcut keys to move from message to message: 

Ctrl + Up                    Move to previous message  



Page | 19   

Ctrl + Dn                    Move to next message 

Resizing panes 

The panes in NEO can be resized. Place your cursor on the divider between the panes you 
want to resize and drag in desired direction. 

              

Changing Folder List sort order 

Each view can have its own sort order. Change the sort order by clicking one of the three 
buttons at the top right.   
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Changing Reading Pane fonts 

There are three message formats for the Reading Pane: HTML, Microsoft Outlook Rich Text, 
and Plain Text. Here's how the change the text characteristics. 

HTML messages 

Change the relative size of HTML text in two ways: 

         Click View menu | HTML Text Size. 

         Set on via Reading Pane options (Tools menu | Options | Reading Pane tab) 

Plain text messages 

Change the characteristics of Plain Text messages: 

         Set on via Reading Pane options (Tools menu | Options | Reading Pane tab) 

Microsoft Outlook Rich Text 

This message format cannot be modified in the Reading Pane. 

Moving the View tabs 

The NEO View tabs are positioned by default at the top of NEO because the tabs are easier 
to access there. You can position them at the top or the bottom of NEO, and you can choose 
to show the graphic symbols or not.  

Right-click on any part of the View tab and make your selection:  

            

Undocking and docking views 

When you start NEO for the first time you will see the default NEO workspace. In it, 
Correspondent view is in the top left panel, Search is below it. The List Pane is on the top 
right and the Reading Pane is below it. 

Optimize view positions to suit your workflow 

All view positions are configurable in NEO. You can undock any view and have it float above 
your workspace, you can dock the views onto the workspace surface in any position, you can 
change the order of the views on the View tab, and you can even hide a view. 

Save your Layout settings by exporting them 

When you have finalized setting your layout, it is best to save your layout settings by 
exporting them: View | Layout | Export Layout.... When it is necessary to reset your User 
Interface it is easy to restore your layout by importing the saved settings. 

How to reset the User Interface 

When you like to restart with the original layout, or when the User Interface needs to be 
reset: 
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Reset your layout             On the View menu, click Layout | Reset Layout. This will restore your 
layout to the default layout. 

Reset User Interface         Close NEO, click Ctr+Shift while double-clicking NEO icon to start the 
program. Confirm dialog to reset the User interface settings. 

Configuring your views 

The key point to remember when moving views is that a view can only be moved to a new 
location when it is undocked (floating). 

Undock a view that is currently docked on the Viewtab 

Double-click the view on the Viewtab. 

Undock a view that is currently docked on the workspace surface 

Double-click the titlebar of the view panel.  

Dock an undocked view back onto the Viewtab 

Drag the floating toolbar's titlebar on top of the Viewtab. As you move it over the tabs, 
drop it when  the insert indicator appears.  

Dock a view onto the workspace surface 

If it is not already undocked, double-click the tab (if on the Viewtab) or double-click the 
titlebar (if already docked on the workspace surface).  

Now that it is undocked, drag it by the titlebar to a dockable location. As you get close to 
a location it will snap into place with a line marker indicating its location. Drop it where 
you like.  

To move it so that it appears as a vertical column, place your cursor exactly on the 
juncture between two stacked panes (for example, the dividing line between the List 
Pane and the Reading Pane).  

Hide and restore a view 

To hide a view, press Alt+F4 when the view has the focus and is undocked.  

To restore a hidden view, go to View menu | click Views then click the view you want to 
make visible again.    

Adding and changing columns 

Column sort order 

Sort your messages by changing the column sort order.      

The indicator on the Date/Time column signifies the current sort column.  Click it again the 
change the sort direction, or click another column to change the sort column. 

Each folder can have a different sort order. 
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Changing column width 

Place your cursor at the start of a column until the resize icon appears (see below), then drag 
it right or left.   

When you change the column width for a view, it changes for all views except Attachment 
view which can be set independently. 

Changing column order 

Left-click drag the header of a column and drag it to the new location. 

Selecting which columns to display 

Right-click on any column. This list of available columns will appear for you to check or 
uncheck.  

List pane Name column  

The Name column in the List Pane shows the From name for incoming messages and the 
To name for outgoing messages. You can also choose to show Original name from message 
in this column. 

Here are the different ways to set this property:   
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Notice above that the folder name is very short to make more room for the original name. 
Also, specifying the folder name in upper case makes it stand out from the original name. 

You can set what's included in the Name column by right-clicking any Correspondent folder 
and choosing Folder Properties.  

Customizing toolbars and the menu 

By default, NEO has one menu and one or two default toolbars. You can customize these in 
several ways: 

         hide or show toolbars  

         move and undock toolbars  

         customize toolbars  
            - add commands 
            - modify commands 
            - remove commands 
            - reset toolbars 

         customize how the menu works  

It's useful to modify your toolbars to add commands you use frequently, or hide ones you use 
infrequently. You can even combine commands onto your own single toolbar to save space.  

Hide or show toolbars 

Right-click anywhere on the menu or toolbar and check or uncheck an toolbar to show or 
hide it. 
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Move and undock toolbars 

Place your cursor over the grip at the left of the toolbar and drag it out of position. As you 
drag it away it will become undocked (floating). You can resize and reshape it while 
undocked.  

As you move it near a dockable location it will snap into place.  

Customize toolbars 

Customize a toolbar by right-clicking anywhere on a toolbar and choosing Customize. 

You can create a new toolbar, rename and delete toolbars you create, and reset default 
toolbars back to their original state. 
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Add a command 

           

Select a command Category then location the desired Command. Drag and drop the 
command onto the toolbar in the location you want.  

Modify a command 

With the Customize dialog visible, right-click a command on the toolbar. A black box 
should appear around it to show you are in edit mode and the command edit will appear.  

            

Delete a command 

Modify a command as per above, and choose Delete.  

Customize menu and toolbar options 

You can change the behavior of the menu and toolbars by going to the Options tab of the 
Customize dialog. 
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Email Improperly Configured on your computer 

You may receive an error issued from Microsoft Outlook when you start Outlook or NEO. 
Here's how to address the problem. 

Ensure you are running the correct Microsoft versions 

NEO works with all Microsoft Outlook versions but does not work with Outlook Express. 

NEO also works with Exchange Server. For Exchange Server Version 5.5 Exchange Service 
Pack 3 or above must be installed. For Exchange 2000 Server,  Exchange Service Pack 2 or 
above must be installed. Your Exchange administrator can provide this information. 

Other ways email may not be properly configured 

NEO requires that both Microsoft Outlook and MAPI are properly configured on your 
computer. MAPI is an email subsystem that is normally installed when you install Microsoft 
Outlook. 

However, components of Outlook and/or MAPI can get corrupted. This can occur when you 
change versions of Microsoft Outlook or add new features, when you change modes such as 
from Internet Only Mode to Corporate or Workgroup mode, or when you use some other 
email programs that replace the correct version with their own versions of MAPI. 

Here are the steps to take to ensure your email subsystem is properly configured. All steps 
may not be required. You may want to print this topic by clicking the Print command on the 
Help toolbar.  

1.   Close NEO, Outlook and any other programs you have running. To be absolutely sure no email 
component programs are running it is best to restart your computer (assuming such programs 
don’t start automatically on startup). The following steps will not work if any part of MAPI is 
running. 

2.   Ensure “Microsoft Outlook” is your default email program. To change the setting: click Start, 
point to Settings, click Control Panel, then double-clicking the Internet Options icon. Click the 
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Programs tab, then choose Microsoft Outlook as the E-mail program. Do not choose Outlook 
Express.  

3.   Run the Microsoft FixMAPI program. This program does not exist on all computers. To find 
whether it exists on your computer, click Start, point to Find then click Files or Folders. Enter  
fixmapi.exe  in the Named field and click Find Now. If it is found, perform the following substeps:  

o    Click Start, point to Find then click Files or Folders. Enter  mapi32.dll  in the Named field 
and click Find Now. Right-click each copy found, click Rename and enter  mapi32.old . If 
you are not able to rename all files then MAPI is running and you should perform step 1 
above. Close the Find program.  

o    Click Start, click Run, enter  fixmapi.exe  in the Open field and click OK. This will run 
quickly and provide no confirmation information that it has completed.  

o    Restart your computer and try NEO.  

4.   Re-install Microsoft Outlook. Perform this step ONLY if step 3 above was unsuccessful.  

o    Click Start, point to Settings then click Control Panel. Double-click the Add/Remove 
Programs icon and then double-click Microsoft Outlook from the list. Have your install CD 
handy.  

o    After re-installation, restart your computer and try NEO.  

If none of the above steps correct the problem, please send an email to support@caelo.com 
describing your symptoms and what steps you have taken.     
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Using with Outlook 

Switching Between NEO and Outlook 

You can switch between NEO and Outlook in two ways: 

From NEO 

1. Click the Outlook button    on the toolbar,  or  

2. Press Ctrl+0. 

From Outlook 

1. Click the NEO button   on the toolbar,  or  

2. Click Tools menu | Switch to NEO Find. 

If the program you are switching to is not open, it will be opened. 

Interacting with Outlook items 

Here are actions you can take on Outlook items from within NEO: 

Switch quickly to Outlook 

Switch to an area in Outlook such as contacts, calendar in two ways: 

a)   Click the Outlook command on the NEO toolbar, or (or press Ctrl+0  (zero)) 

b)   Click the black triangle to the right of the Outlook command on the NEO toolbar and choose 
to go to a particular area of Outlook, or press these shortcuts to go to: 

               Ctrl+0   Outlook  
         Ctrl+1   Inbox     
         Ctrl+2   Calendar 
         Ctrl+3   Contacts 
         Ctrl+4   Tasks 
         Ctrl+5   Notes 
         Ctrl+8   Journal 

c)   Double-click an Outlook non-mail folder    in Outlook view. 

Work with Outlook mail folders   

In Outlook view, work with these just as you would your folders in Outlook. 

Interacting with Contacts and Address Books 

NEO interacts with Contacts in two ways. 
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When creating new Correspondent folders 

When automatically creating a new Correspondent folder, NEO imports relevant contact 
information such as name, company, telephone numbers and email addresses. 

NEO first checks to see if a Contact exists for the address based on an email address match. 
If a Contact matches, correspondent information is taken from the Contact. If no contact is 
matched, then NEO does a lookup in all Address Books for a matching entry. If a match is 
found, correspondent info is taken from the Address Book. NEO adds all addresses from the 
Contact/AddressBook to the Correspondent folder, except for addresses that already exist in 
NEO.  

Note that this is a one-time import from Contacts and is not synchronized in an ongoing way. 
If you make changes to the Correspondent fields they are not then reflected in your Contact. 

How NEO Works with Exchange Server 

NEO works with Microsoft Exchange Server mailboxes. However, NEO is an email organizer. 
It does not organize other Outlook object types such as calendar items, journal items, and 
note items. 

Here are some notes about using NEO with Exchange Server: 

NEO is a client-side product 

That means NEO installs and operates completely on your computer. There is nothing about 
NEO that gets installed on the server or that is related to Exchange Server. In fact, Exchange 
Server is completely unaware of NEO.  

You can organize your Mailbox, your PSTs and your IMAP folders 

If you are using NEO you can include your mailbox and as many PSTs or IMAP folders as 
you like in your catalog. NEO will give you a seamless view to all your messages as if they all 
reside in one large single area. 

Using your offline message store (OST) 

When using Offline mode, a Full Sync may sometimes be needed to updated deleted 
messages in NEO.  

Offline mode using Outlooks prior to Outlook 2003 

If you have offline access enabled (you use an offline message store), you should select 
all your email folders for OST/Mailbox synchronization. In addition, you should not set 
filters for your folders.  

You will not lose messages when you do this; however, if you do not include all your 
folders NEO may spend quite a bit of time removing and adding messages in the catalog 
each time you switch between your OST and your mailbox.  

If you have instructed Outlook to automatically Outlook synchronize your Exchange 
mailbox with your OST when exiting an online session, you must shut down Outlook 
without NEO running for the synchronize to be performed.  
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Cached Exchange Mode in Outlook 2003/2007 

NEO works with normally with Cached Exchange Mode.  

Reminder – Synchronize each time you re-connect to the LAN 

Whenever you re-connect to the LAN, you must synchronize to update NEO with new 
messages from your mailbox. Note that you can configure NEO to automatically Fast Sync 
on startup. 

Synchronizing with Outlook 

NEO normally displays all the messages in your message store(s). However, NEO doesn't 
know about new, changed or deleted messages that are processed when NEO is not 
running. 

How it works ... in a nutshell 

If NEO is running when new messages arrive, are changed or deleted, then you'll always see 
all your messages in NEO (NEO keeps you synchronized on-the-fly). 

If NEO is not running, then NEO will not know about these message events and will need to 
get synchronized again by you syncing manually (e.g., when you next start NEO). 

Always run NEO 

It’s best to always have NEO running when Outlook is running so your email stays 
synchronized. You can configure from the Tools | Options menu to start NEO together with 
Outlook. You can even select to start NEO minimized in the tray so it will never be in your 
way when starting Outlook.   
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NEO Views 

Overview - Views 

The power of NEO Find 

NEO Find contains Caelo’s patented short-cut technology to show messages automatically in 
more than one location without copying the message. 

NEO Find contains the three most frequently used views (Outlook, Correspondent and 
Search) for you to easily retrieve your emails. FYI: NEO Pro has nine different views. 

In views, messages appear in more than one location at the same time. Every message will 
always be in the Correspondent folder of the person communicated with. It will also always 
be in the Outlook folder containing the message. It can further be in a search results folder in 
the Search view if you find it in a search. Once a message is deleted, it will be removed from 
all your views. 

It is important to realize that the Correspondent Folders are always referencing ALL 
messages from a single Correspondent (whether Sent or Received). So, even when a 
message is moved within the Outlook system (e.g. from the Inbox to another folder), it will 
still show in the Correspondent Folder as if it did not move – in fact, the reference in the 
Correspondent Folder for this message is automatically updated to the new location when 
moving a message (you can see the changed location in the Preview Pane where the 
containing folder is shown). 

In short, even though you see the same message in different views, it’s really just one 
message presented to you in different ways. 

This now is the beauty of NEO Find: although messages may move within your Outlook 
system (and you may forget where it is filed away), you will always find all your messages to 
or from a person in the Correspondent Folder – no matter where it is located in your Outlook 
system. 

Using views 

Views don’t require any work – they’re set up and maintained automatically for you to use. 
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Outlook View 

 
Outlook View 

Outlook view is your view into your Outlook 
Folder List. 

The example at left shows multiple message 
stores (PST files).    

Correspondent View 

 

Correspondent View 

Lists all people you correspond with. These 
include people you send messages to and 
people who send messages to your email 
address(es). 

Although these folders are virtual folders (they 
do not exist in reality in your Outlook system), 
they behave like real folders – most importantly 
you can search through these folders using the 
Search facility (press F6 to launch a Search in 
Folder).    
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Search View 

 
Search View 

NEO's search is an indexed search facility. It's 
extremely fast because all the words in all your 
messages are automatically indexed. 

Besides a search through the entire Outlook 
system, Search is particularly powerful to 
search through the virtual Correspondent 
Folders (select a Correspondent Folder and 
press F6 for a Search in Folder) 

In NEO Find you can save search folders (as 
shown at the bottom).         
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Working with Messages 

Once messages are found 

Once you have found a message (see Chapter: Finding Emails), you can perform several 
actions. 

Open a message  (Enter or Ctrl+O) 

Double-click a message in list view, or select a message and press Enter of Ctrl+O to open a 
message in Outlook. 

View message thread  (F7: Search for Conversation) 

  Press F7 to find related messages in same conversation thread (see below). 

Reply to a message   (Ctrl+R) 

Click the Reply toolbar command, or enter Ctrl+R. After entering the message contents, 
click Send. 

Reply to all respondents in a message   (Ctrl+Shift+R) 

Click the Reply All toolbar command, or enter Ctrl+Shift+N. After entering the message 
contents, click Send. 

Forward a message   (Ctrl+F) 

Click the Forward toolbar command, or enter Ctrl+F. After entering the address 
information and the message contents, click Send. 

Jump to Folder   (Ctrl+J) 

  Jump to the containing folder of the message. When folder is organized in more than one 
folder, a selection screen will show to select the folder to jump to. 

Use message as attachment 

When you like to add the message as attachment to a new message, simply drag-and-drop the 
message from NEO’s message list to the new mail window. 

File message to another folder   (Ctrl+F) 

Right-click the message and select File to Any Folder. 

Mark Read/Unread   (Spacebar / Shift+Spacebar) 

Pressing Spacebar or Shift+Spacebar will mark a message Read or Unread. 
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Delete a message   (Del) 

Simply press the Delete key to move a message to the Deleted Items folder. Pressing Ctrl+Z will 
undo this delete action. 

Moving Back and Forward 

Use the back and forward commands to quickly jump back or forward to previously-visited 
folders. This is very useful, for example, after performing a search. 

The Back and Forward buttons are located on the right side of the header above the list 
columns: 

     

Or press Alt+Left for Back or Alt+Right for Forward. 

Search on Conversation   

To quickly see all related messages: 

         Click    on the Standard toolbar, or 

         Press F7. 

You will then be quickly positioned in Search view with all messages based on the same 
'conversation' displayed.     

When done, click     or press Alt+LeftArrow to go back to the folder your came from. 

About 'Conversation' 

Every message has a property called Conversation, and it is usually the same as the Subject 
property but it can be different. 

When a new message is created, the current Subject is copied to the message's 
Conversation. However, if the Subject is edited, the two will be different. Conversation 
always remains as the original Subject. 
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Deleting Messages 

Deleted messages go to Deleted Items 

To delete a message or messages, highlight the message(s) and press the Delete key 

When messages are deleted in NEO they are moved without warning to your Deleted Items 
folder in Outlook. You can get them back if you need to by moving them from Deleted Items 
to another folder or by pressing Ctrl+Z (Undo) immediately after the delete action. 

Note:    When you delete a message, the message will be removed from all views within NEO. 

Deleting saved search folders  (Alt+Del) 

If you delete a saved search folder (Alt+Del), just the saved search results are deleted – the 
underlying messages remain. 

Undoing Actions 

You can UnDo (reverse) some operations in NEO. Keep in mind that only the last action can 
be undone. 

To UnDo an action, press Ctrl+Z or select UnDo from the Edit menu.   
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Viewing Message Properties 

Right-click any message in list view then click Message Properties.  

Location lists the NEO folders that contain the selected message. This is especially useful 
for determining in what Correspondent and Outlook folder a selected message is stored in. 
Note that you can also see what Outlook folder a message is stored on the Folder field on 
the Reading Pane header.   

Message Symbols 

See Reference section at end of Help.   
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Working in the Reading Pane 

NEO’s Reading Pane 

The Reading Pane displays beneath or to the right of the Message List Pane. 

Reading Pane Options 

These options relate to the Reading Pane.  
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Clicking Links to Launch Your Browser 

If your browser is open when you left-click a web link, the page replaces the current page 
loaded in your browser.  To launch a web-link in a separate browser window, left-click the 
web link while holding down the Shift key. 

Click link Launch web-link in your current browser window (replacing currently loaded 
page).   

Shift+Click link Launch web-link in a new browser window. 

See keyboard shortcuts on the Help menu for a list of all keyboard shortcuts. 

Resizing the Reading Pane 

The Reading Pane can be positioned either at the bottom or to the right of the screen. This 
can be defined on the View menu. Size of the Reading Pane can be changed to any desired 
size by dragging the pane separator to a new location or by using the keyboard shortcuts. 
Switching off the Reading Pane can be done through the View menu. 

Keyboard shortcuts  

Ctrl + Alt + Up Reading Pane On 
Ctrl + Alt + Down Minimize Reading Pane 

Shift + Ctrl + Up Increase Reading Pane 

Shift + Ctrl + Down Decrease Reading Pane 
Shift + Ctrl + PageUp Maximize Reading Pane 

Shift + Ctrl + PageDown Restore Reading Pane  

Note that you don't have to see the List Pane messages in order to read them in the Reading 
Pane. You can use the following shortcut keys to move from message to message: 

Ctrl + Up                    Move to previous message  
Ctrl + Dn                    Move to next message 

Changing Reading Pane Fonts 

There are three message formats for the Reading Pane: HTML, Microsoft Outlook Rich Text, 
and Plain Text. Here's how the change the text characteristics. 

HTML messages 

Change the relative size of HTML text in two ways:  

o    Click View menu | HTML Text Size. 

o    Set on via Reading Pane options (Tools menu | Options | Reading Pane tab) 
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Plain text messages 

Change the characteristics of Plain Text messages:  

o    Set on via Reading Pane options (Tools menu | Options | Reading Pane tab)  

Microsoft Outlook Rich Text 

This message format cannot be modified in the Reading Pane.   

Choosing the HTML Reading Pane Viewer 

What is the HTML Reading Pane? 

Messages displayed in the Reading Pane are displayed in one of three formats: Plain Text, 
Rich Text, or HTML. The HTML Reading Pane Viewer displays messages when they are in 
HTML format. 

In NEO, the default HTML Reading Pane Viewer is the Microsoft HTML Viewer. This is the 
same viewer that is used in the Outlook Reading Pane.  Our Internal HTML Viewer is a 
simpler viewer with considerably less extensive display capabilities. 

Which viewer should you use? 

We recommend that you use the Microsoft HTML Viewer. Here are the differences between 
the two.  

Microsoft HTML Viewer

 

Internal HTML Viewer

 

Works with Internet 
Explorer versions 5.0 and 
above (not selectable with 
pre-IE5.0) 

Works with Internet 
Explorer versions 4.0 
and above. 

Displays messages just 
like Outlook does in its 
Reading Pane. 

Does not display some 
HTML objects as well. 

Faster display when 
moving from message to 
message. 

A little slower. 

Email security (see 
below) 

Email security (see 
below) 

More information about Email Security 

In general, message Reading Panes can and have been vulnerable to email viruses. 

When choosing the Microsoft HTML Viewer, NEO uses the security zone settings in Outlook 
in Options | Security. Taking it one step further, NEO also ensures scripts will never run and 
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ActiveX controls are deactivated regardless of your version of Outlook or security zone 
settings. Note that using the Microsoft HTML Viewer in the NEO Reading Pane is no riskier 
than the Outlook reading/preview pane, and may be safer. 

The Microsoft HTML Viewer is a component of Microsoft Internet Explorer. You get the latest 
version whenever you update your Internet Explorer. To minimize security risks Microsoft 
strongly recommends that you periodically download and install the latest critical security 
updates for Internet Explorer, which can be obtained from 
http://www.microsoft.com/windows/ie/default.asp. This can be automated if you wish by using 
Microsoft's Windows Update. 

NEO's Internal HTML Viewer is safe regardless of your version of Outlook or your security 
zone settings, but is not as rich in its display capabilities. 

Note:  We may discontinue support for the Internal HTML Viewer in future versions of NEO.      

http://www.microsoft.com/windows/ie/default.asp
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Filtering 

Filtering Overview 

Filtering is ability to temporarily show certain types of messages. It's great for zeroing in on 
certain types messages such as Sent or Received messages.  

Filter basics 
         Filters are fast. They can be set and cleared very quickly. 

         Filters are temporary. They never affect your messages, just what folders or messages that you 
see. You can always clear them. 

         Filters are global - they operate across all message stores, views and NEO folders.  

         Filters are sticky - if you set a filter it remains in place until you change it, even if you restart 
NEO. 

         When a filter is 'on', the background of the List Pane and/or the Folder List changes color to 
make it obvious a filter is applied. 

Filtering in NEO Find 

NEO Find has a Filter toolbar. The Filter toolbar consists of filter sets that fit together 
logically. You can combine your filters in any combination that you like. 

Below the Filter toolbar is shown in its filter sets:    

Filter Controls:  Clear clears the filter so that all 
messages show. Disable, temporarily disables the 
filter so you can quickly see all the messages. 
Clicking Disable again reinstates your current filter.   

Folder:  Shows only folders with Unread 
messages. This filter is a folder filter and acts on the 
Folder Lists.  

Message Status:  Choose from Unread, Unfiled, 
Flagged or Important, singly or in any combination.   

Direction:  Show Received messages only or Sent 
messages only.  

Date filter:  A flexible From… To… filter.   

Message age in Days:  Message age from today. 1 
day shows today's messages, 2 days shows today's 
and yesterday's messages, and so on. 
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How to tell when a filter is on 

Whenever a filter is on, the background color of parts of NEO display in a different color. For 
folder filters ('Show folders with Unread'), the Folder List background color is changed. For 
message filter sets (all others) the Message List Pane background is colored. You can 
change the background color in options. 

Clearing a Filter 

To clear the filter in NEO, simply click the filter commands again so that they are disabled 
(they show without a border).    



Page | 44   

Folder Lists 

Overview to Folder Lists 

Each NEO view has its own Folder List. When a folder in the list is selected its messages are 
displayed in the List Pane.     

Folder Basics 
Folders are containers for your messages. The operations you can perform on folders vary 
depending on the type of folder. To see the available operations for a folder, right-click the 
folder. Here's are the available operations for a Correspondent folder: 
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Common folder operations 
Search in folder          Go to Search view with the folder selected for searching. 

Combine folders        Combine one folder with another. You can also drag and drop the source 
folder onto another. 

Remove folder           Delete a folder without deleting the underlying messages - Alt+Del. 

Rename folder           Change the name of a folder - F2. 

Folder properties        View the folder properties - Enter or double-click. 

Special folder operations 
Empty folder              Permanently delete the folder's messages (available for Deleted Items and 

Spam Folders).  

Make Current              For views containing the New, Current, Dormant folders, move folder into the 
Current area. 

Make Dormant            For views containing the New, Current, Dormant folders, move folder into the 
Dormant area. 

Refresh search           Re-run a search folder to update it based on its search parameters. 

Jump to Outlook        Jump to the corresponding Outlook folder. Do this for Contacts, Calendar, etc. 
as well as your user-defined folders - Enter or double-click. 

Finding Folders in the List 

The fastest way to find a folder in long Folder Lists is to use the Folder List Filter. Enter 
characters into the textbox at the top, and the list will display only those folders with the 
characters in it. 

For example, to quickly find Mary Jennings folder, entering 'mary' is sufficient to reduce the 
folder set to a small enough set to select it. 
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Notice that when a filter is in effect, the background is displayed in the filter background 
color.  

Here are some shortcut commands to make working with the Folder List Filter easier: 
Esc

 

Clear the Folder List Filter 

F3

 

Jump to the Folder List Filter in the current view 

F5 Jump to the Correspondent Folder List Filter.  
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Sorting the Folder List 

Each view can have its own sort order. Change the sort order by clicking one of the three 
buttons at the top right.  

Expanding and Collapsing the Folder List 

When in Tree Sort Order, the tree displays in a hierarchy. Expand a branch by clicking the 
Plus  symbol. Collapse a branch by clicking the Minus  symbol. 

Keyboard shortcuts (using the number keypad): 
Num +                    Expand current folder in Folder List 

Num -                     Collapse current folder in Folder List 

Shift+Ctrl+Num +   Expand all folders from anywhere in list 

Shift+Ctrl+Num -    Collapse all folders from anywhere in list 

Top-level folders – New, Current and Dormant 

Some views have top-level folders. Top-level folders are folders managed automatically by 
NEO to help you organize your folders. You can also organize folders in top-level folders 
manually. 
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In Correspondent view the New top-level folder displays all folders that have been newly 
created.. 

Automatic organization 

You can choose to have NEO automatically move Correspondents from New to Current, and 
from Current to Dormant based on day-age parameters you provide.  You can also specify 
that Dormant folders are moved back to Current when they become active again (e.g., 
receive a message). 

You could specify that New folders automatically move to Current after 30 days, and Current 
folders automatically move to Dormant after 365 days of inactivity. A folder remains inactive 
until a significant event occurs such as it receives a message.  

By disabling automatic moving of folders you would retain control over where a folder is 
located. 

To set the automatic organization of folders, right-click a top-level folder such as New, 
Current and Dormant and choose Folder Properties. 

Manual organization 

You can manually move folders from New to Current, Current to Dormant and so on in two 
ways: 

1. Drag and drop the folder from one group onto the branch of the other. Drop it on the top-level 
folder itself (e.g., Current). It you drop it on a folder, NEO will think you wish to combine folders. 

2. Right-click the folder and choose Make Current or Make Dormant.   
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Folder Properties 

General Folder Properties 

These properties apply to all Search folders.     

Top-level folder properties 

Top-level folders group your folders at the highest level.     
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Correspondent folder properties 

These properties apply to Correspondent folders.      

Back to Table of Contents
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Outlook Folders 

Overview – Outlook Folder List 

Outlook view is your view into your Outlook Folder List. 

 

Your mail folders:     Your user-
defined mail folders in this pane are your 
actual Outlook folders.   

Outlook folders:      Your special 
Outlook folders such Drafts, Deleted Items, 
etc. are also here.  

Non-mail folders:      These are shown 
but cannot be accessed from within NEO 
Find.    

Working with user-defined folders 

The folders you create in Outlook are visible to you here. In fact, the folders in Outlook view 
are your actual folders in Outlook. 

Viewing user-defined folders in NEO 

Simply select any folder in the Outlook view, just as you would select any folder in the NEO 
views. 

Moving messages to Outlook folders 

Move any message from anywhere in NEO to your user-defined folders. Simply drag and 
drop the message(s) onto the folder or right-click the message and select File to Any Folder. 

Copying messages to Outlook folders 

Right-click drag the message to a user-defined folder. When you release you will be 
prompted as to whether you want to copy or move. 
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Excluding folders from being organized in NEO 

You can exclude messages from Outlook folders from being organized into Correspondent 
folders. 

You would typically do this for Spam folders, but you can also do it for any folder that you 
don't want to see in NEO. 

To change the Exclude setting: 

1.   Right-click on the folder in Outlook view. 

2.   Select Folder Properties. 

3.   Set the option in the Exclude from NEO section. 

Note that by default, Excluded messages are included in NEO searches. However, you can 
optionally choose to search all folders except Excluded and Deleted Items.   
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Correspondent Folders 

Overview 

Overview 

All mail in NEO is automatically organized into Correspondent Folders. As this is most 
natural way people tend to think about their email, this automatic organization provides a 
very easy and intuitive way of finding older emails back. It is not relevant anymore where 
emails are filed away as they will always appear where they are expected to be: in the folder 
of the correspondent involved in the communication. 

Correspondent folders contain all Sent and Receive emails – no matter where they are 
located within your Outlook system. Also when emails are moved around (being filed or 
moved into an archive folder), they will continue to show in the Correspondent Folder as 
NEO will automatically update the reference to the email when they change location. 

Correspondent Folders 

All your mail is automatically organized by Correspondent 

NEO automatically creates Correspondent folders as you communicate with new people. All 
subsequent messages are automatically filed by correspondent. 

These are virtual folders. The messages are seen here in addition to the Outlook folder 
they are permanently stored in. 

     

Both Sent and Received 
messages are shown 
together. 

New Correspondents arrive 
into the New area. You can 
manually move folders to 
Current or the Dormant 
areas. 

Or you can set parameters to 
have the Correspondent 
folders move automatically 
between levels according to 
message activity based on 
date. 
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Keeping Your Addresses Up to Date 

About Your Addresses 

NEO needs to know which addresses are yours in order to automatically organize your 
messages. If all your addresses are not entered, your messages will not appear correctly.  

Note that NEO must know all your addresses - not just your currently used ones. Be sure 
to include your old addresses if you have messages that used them.  

Auto-detecting your addresses on catalog creation 

NEO automatically detects your addresses when you create a catalog, and you can add to 
the list NEO auto-detects. Addresses you enter are displayed in bold.  

Important Note:   NEO does not auto-detect addresses you use after creating the catalog. 
You have to enter these manually. 

Adding and removing addresses 

You can add addresses and you can remove addresses you add. Addresses NEO auto-
detects can not be removed - however, you can choose not to include them by unchecking 
them)  

Click File menu | Your Addresses: 
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To add an address, click the Add command. POP3 email addresses are entered in the usual 
way (e.g, bcoopersmith@fbi_NY.com). Exchange Server addresses are enter in X.500 
format. 

Working with Correspondent Folders 

Keeping name folder information up to date  

As you correspond with new people, new Correspondent folders will automatically be created 
for them and will appear in your New top-level folder. NEO creates the name information for 
you. 

In many cases, however, not enough information is provided and the name folders will simply 
be email addresses. In other cases, NEO may interpret the name and organization 
incorrectly. 

When a same person is sending emails from two different email addresses, this will result in 
two different Correspondent Folders for this person. Combining these folders will collect all 
emails from both email addresses into a single Correspondent Folder. The email addresses 
associated with a Correspondent Folder can be found by right-clicking the folder and 
selecting Folder Properties. 

How to update correspondent names 
1. Quickly change a name in the Folder List by selecting the name and pressing F2. Then edit the 

name.  Alternatively, you can right-click the folder and choose Folder Properties.  

2. You can quickly combine two names together by dragging one name into another name in the 
View pane, or you can right-click the folder and choose Combine Folder. 

Combine two names / folders 

You will want to combine two names together when someone you correspond with has more 
than one email address. 

When you combine names, you select the name you want to combine and then select the 
name you want to move it to. The first name disappears, and the second name gets the 
address(es) from the first name. 

Combine names using drag and drop 

In the View pane, drag the name you want to combine onto the name you want to combine it 
into. 

Combine names using the Combine Folders command 

Alternatively, you can right-click the folder you want to combine into another folder, then click 
Combine Folders.  You'll then be able to choose the other folder to combine it into.  

Updating address information 

The Correspondent folder's addressing information is entered on the Folder Properties for 
the folder. To get there, right-click the folder and choose Folder Properties (or double-click 
the folder). 
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Addressing for the folder is entered in the following section of the Folder Properties. 

     

Adding and changing address information 

Click Add or Change. You can add as many addresses as you like. The same address can 
be in more than one folder.  

Moving an address to another folder 

Move an address out of a folder to another folder by highlighting the address or address 
pattern clicking Move.  

Your Folder List will appear. On it you can move to an existing folder in the Folder List by 
highlighting it and clicking OK, or you can add a new folder by clicking the New command at 
the bottom.  

Removing an address 

Highlight the address or address pattern you want to remove and click Remove. Remove 
never removes or deletes messages. It just removes the address from the current folder. The 
messages related to the address will then be auto-organized again by NEO and will appear 
in a separate Correspondent folder. 

Entering Email Addresses and Names  

Entering an address 

Enter SMTP addresses (e.g., jkwan@prime.com) or X.500 addresses. If entering X.500 
addresses, it's easiest to use the Lookup User command. Exchange addresses are normally 
displayed using the address name and is often underlined. 

Entering an address pattern 

You can enter address patterns for SMTP addresses. A pattern may contain any combination 
of the wildcard characters * or ?. A * will match any number of characters and a ? will match 
any single character. 

Patterns apply to the part of the address before the @ symbol (they don't apply to the domain 
portion). Patterns can also apply to address names (with a Name= prefix). 

Example patterns: 

*@caelo.com Represents all addresses with a domain of caelo.com 
such as support@caelo.com, affiliate@caelo.com and 
so on. 
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jk*@prime.com Represents addresses starting with jk at the 
prime.com domain: jk@prime.com and 
jkwan@prime.com. 

jk?@prime.com Represents addresses starting with jk at the 
prime.com domain with exactly 3 characters before the 
@ sign: jk1@prime.com and jk2@prime.com but not  
jtkkwan@prime.com. 

CNET_*@newsletters 
.online.com 

Ideal for capturing emails that change each time: 
CNET_#3.106@newsletters.online.com,  
CNET_#3.503@newsletters.online.com, and 
CNET_#3.618@newsletters.online.com 

Name=Outlook* 
@online.com 

Represents all address names beginning with Outlook 
at the online.com domain:  Outlook-
Users@online.com, Outlook-Developers@online.com 
and Outlook-Administrators@online.com 

Renaming Correspondent Folders 

Renaming a name folder 

Right-click the folder you want to rename and choose Rename Folder (F2).  Enter the new 
name. Names are automatically formatted according to the name format you have specified 
in the Format options.     
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Attachments 

Overview - Attachments   

If attachments exist for a message, a paperclip will appear in the attachment column of the 
message list pane, and a paperclip will appear on the right side of the message preview 
header. 

Attachment security   

Email attachments can contain programs or other executable objects. If the attachment 
happens to be a computer virus then opening the attachment, either within the message or 
later when you have saved it, can cause serious harm to your computer. Viruses can also 
harm the computers of your correspondents if you spread it by sending them a message, or 
even simply by having them in your address book.  

To help reduce the spread of viruses, security measures are available to you. The 
attachment behavior in NEO mimics the behavior in Microsoft Outlook. 

Important:     NEO does not scan for, identify or protect you from viruses. Only what types of 
attachments are permitted for opening and/or saving is controlled. 

Be sure to exercise caution when dealing with attachments. 

The type of security available in NEO depends on the security you have installed in Outlook. 
In June 2000, Microsoft made available an optional update called the E-mail Security 
Update. The security update provides for much stricter attachment control than previously. 

Microsoft E-mail Security Update installed 

NEO exactly mimics the behavior of the Microsoft update. To modify your settings in NEO, 
consult your Outlook documentation and make the changes in Outlook. NEO will observe 
those settings. 

Microsoft E-mail Security Update NOT installed 

Certain file types may be saved to disk only. Other file types may be opened or saved to 
disk. In NEO, the list of file types that can be saved to disk only is the same as the list used 
in Outlook. However, the NEO list can be modified in the registry. 

Changing the save-to-disk only list 

Note that you should not make changes in the registry unless you are very confident in what you are 
doing. The registry setting to change is: 

NEO Find:  HKEY_CURRENT_USER\SOFTWARE\CAELO SOFTWARE\NEO 
FIND\1.0\OPTIONS\ALERTEXTENSIONLIST 

Simply add or remove from the list, being sure to preserve the format.  
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Alternative for confirmation prompts for a file type 

When you save or open certain types of files, you can uncheck a box that says "Always ask before 
opening or saving this type of file."  If you do, it will subsequently automatically open or save the 
attachment when you click the attachment name from the icon. However, when clicking the 
paperclip icon, NEO now also shows a “Save Attachment” icon below the file name to allow the user 
a choice to save the attachment. 

Re-enabling confirmation prompts for a file type 

When you save or open certain types of files, you can uncheck a box that says "Always ask before 
opening or saving this type of file."  If you do, it will subsequently automatically open or save the 
attachment when you select it. 

You can re-enable prompting again for one or more file types by editing the following registry entry: 

NEO Find:  HKEY_CURRENT_USER\SOFTWARE\CAELO SOFTWARE\NEO 
FIND\1.0\OPENATTACH 

Simply remove the entry(s) associated with the extension of the file type in question (e.g., remove 
DOC entries to re-enable prompting for Word DOC attachments).  

Opening attachments  

To open an attachment, click on the paperclip at the right of the message preview header. It 
the entry is grayed-out (disabled), attachment security has prevented you from accessing it. 

Choose Open it.  

To help prevent computer viruses, certain types of files may not be opened. To open these 
types of attachments, save them to disk and open them there, after you have ensured they 
do not contain viruses.  

Saving attachments   

To save an attachment, click on the paperclip at the right of the message preview header. 

Choose Save to disk. With multiple attachments, the option to Save All Attachments is 
available to save them all at once to disk. 

You may open saved attachments after you have ensured they do not contain viruses.  

Removing attachments   

If you delete a message that contains an attachment, all the objects attached to the message 
are also deleted. 

To remove an attachment from a message (and keep the message), follow the following 
steps: 

1. Open the message in the message editor (double-click the message or enter Ctrl+O).  

2. Select the attachment(s) you want to remove. 

3. Right-click and choose remove. 
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Note that when you remove attachments in this way, they are permanently removed (they do 
not go to the Deleted Items folder).   
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Searching   

Searching 

Entering search words and phrases 

Unlike Outlook that searches for word strings, NEO searches for whole words.  

For example, in Outlook entering “ever” returns messages with “ever”, “every” and “Everest” 
in them. Whereas in NEO entering “ever” returns messages with “ever” (or “Ever”) in them.  If 
you want to get variants of “ever” you would enter “ever*” (add wildcard “*” behind the search 
word). 

Easiest way to start a search 

 

From anywhere in NEO, run a new search by clicking   New Search on the Standard toolbar 
(or press F8). 

 

From within Search view, click Clear (or press Esc).  It's a good idea to get in the habit of 
clicking Clear before each new search because it resets all parameters and puts you in the text 
field. Please note that “Match Similar Words” is a sticky option which is not reset when clicking 
Clear, 

Then simply enter a word or words into the white field at the top of the Search view, then 
click Go (or press Enter). 
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Entering search parameters  

How to enter words to search 

Search finds all messages containing the words you provide. A message is selected if your 
provided words are found anywhere in the message subject, message body, or address 
information.  

Search expressions and examples 

 

Unless you direct otherwise, if you enter more than one word, messages are found that contain 
any of the words.  

Ex:    red green blue   (same as entering red or green or blue) 
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Whole words are searched for. 

Ex:    handle will find handle but not handlebar 

 
Use the wildcard character * to search for words ending in an unknown sequence. 

Ex:    handle* will find handle and handlebar 

 
Use quotes to locate exact phrases 

Ex:   "in that case" finds messages where words are exactly as shown.  

 
Searches are case-insensitive - it's easier to enter as lower case. 

Ex:    monday will find monday and Monday 

 

The words and, or, not and near can be entered, and parenthesis can be entered to control 
order of execution. 

Ex:    (car or bus) near accident finds messages containing car or bus if either word is within ten 
words of the word accident 

Ex:    car or (auto not bus) finds messages containing car and messages containing auto that 
don’t contain bus.  

 

Punctuation is replaced by blanks before the search (except for *).  

Ex:    Standard&Poors is the same as entering Standard Poors.  

About word indexing 

Searches are fast because NEO creates and uses a separate listing (index) of all the words 
in all messages to speed up lookups. 

Word indexing takes place in two places: in the background or by updating the word index 
manually. 

Automatic background word indexing 

NEO indexes all your messages regularly according to a time frequency in minutes you specify. 
See Tools menu | Options | General tab to see how to set how often you want background indexing 
to occur.  

Manually updating the word index 

Since your word index may be slightly out of date while between background indexes, you can 
force an update of the word index from Tools | Update Word Index or by clicking the update word 
index icon    in the Search parameters.  

In practice, it's quite rare that you will need to search for messages that you have just received, so 
it's probably not worth forcing a manual update unless you are looking for a very recent message. 

Saving Searches 

Normally when you run a search the results appear in the Current Search Results folder, 
replacing the results of your previous run. This is the most common use of search - simply 
searching to quickly locate a message you need once. 
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If you have a recurring use for search results, you can save the search parameters and 
results in its own folder.  

About Search Folders 

 
Both the parameters and the results are saved.  

 
The results remain the same until you refresh them (they’re static). To refresh the results to 
include recent messages, right-click the folder and choose Refresh Search.  

 

When you run a search, the results and parameters you enter always replace the currently 
selected Search Folder. Most often this is Current Search Results, but if it is a differed search 
folder the parameters and results will replace it.  

Working with Search Folders 

Saving a Search 

 

Run a search:  click Clear, enter words to search, then click Go.  

 

Click the Save Search command  . 

 

Optionally, rename the search folder (see next section).  

Renaming a Search Folder 

 

Right-click the folder and choose Rename Folder (or press F2).  

Refreshing a Search Folder 

 

If you simply want to update the results, right-click the folder and choose Refresh Folder. 

 

If you want to edit the parameters, select the search folder, change the values, run the search, 
then click the Save Search command. 

Removing a Search Folder 

 

To Remove a search folder, right-click the folder and choose Remove Folder (or press Alt+Del). 
Your messages will not be removed. 

Searching in a Folder 

You can Search within a (Correspondent) Folder in two ways: 

1.   Right-click any NEO or Outlook folder and choose Search in Folder (or click F6): 

          

2.   Choose the Search view Folder menu. When you click a view listed you will be able to 
choose a folder within it.  
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Excluding Excluded and Deleted Items in Search 

In Search view you can choose to search All Folders, any selected folder or choose to 
search All Folders except Excluded and Deleted Items.  

           

The choice you make remains in effect until you change it. To clear your other search 
parameters, click Clear. 

Why saved searches are useful   

Suppose you are budget responsible for your department and are working for 3 months to 
finalize budgets for next year. All messages related to this project contain the words Budget 
FY06. 

You could create a search with words to search:  “budget FY06”.  If you saved that search 
result, as “Budget FY06”, you could rerun the search whenever you wanted by clicking 
Refresh Search (right-click the Search Folder). Your search results would then be updated to 
include all new messages since the last time you ran the search. When finished with the 
project, you can simply remove this folder (Alt+Del) while all your messages remain within 
Outlook. 

Search on Conversation   

To quickly see all related messages: 

 

Click   on the Standard toolbar, or 

 

Press F7. 

All messages based on the same 'conversation' will be displayed.    

When done, click    or press Alt+LeftArrow to go back to the folder your came from. 
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About 'Conversation' 

Every message has a property called Conversation, and it is usually the same as the Subject 
property but it can be different. 

When a new message is created, the current Subject is copied to the message's 
Conversation. However, when the Subject is edited, the two will be different. Conversation 
always remains as the original Subject.     
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Junk Mail - Spam 

Excluding Spam Folders from NEO 

Many people use programs to automatically detect and isolate spam (junk mail) into one or 
more Outlook folders. Later versions of Outlook have this feature built in, and many third 
party programs have more extensive capabilities. 

NEO supports these programs by allowing you to exclude messages going into these spam 
folders from NEO folders. The excluded messages are still viewable in your Outlook folders 
(via NEO's Outlook view) - they just aren't included in NEO's Correspondent Folders. 

How to exclude folders from NEO 

You can exclude any Outlook user folder that you define. In fact, it isn't restricted to spam 
folders. You may want to choose to exclude other user-defined folders too. 

 

Right-click the folder in NEO Outlook view and choose Folder properties,  

 

Check the "Folder is not organized into NEO folders" checkbox 

How it works 

 

When a message is moved into your designated spam folder, the message is excluded from 
NEO. If it is moved out of your spam folder, it becomes included in NEO.  

 

This happens whether your program automatically handles the message or you handle it 
manually.  

 

Excluding starts from the time in which you add the folder to the list in NEO, and stops when 
you remove it.  Therefore it may be that your designated folder has some messages that are 
excluded and some that are included.  We recommend that you empty the spam folder before 
adding it to the NEO list.     
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Synchronizing with Outlook 

About Synchronizing with Outlook 

NEO normally displays all the messages in your message store(s). However, when NEO is 
not running NEO doesn't know about new, changed or deleted messages that are processed. 

How it works ... in a nutshell 

If NEO is running when new messages arrive, are changed or deleted, then you'll always see 
all your messages in NEO (NEO keeps you synchronized on-the-fly even when hidden in the 
System Tray).  

If NEO is not running, then NEO will not know about these message events and will need to 
get synchronized again – therefore it is advised to configure NEO to Fast Synchronize on 
startup (Tools | Options).  

How to stay synchronized 

It helps to understand synchronization because it can affect what messages you see in NEO.  

Recommended way to stay synchronized 

We recommend all users enable the option Fast Synchronize on Startup. It syncs quickly and 
runs in the background so that it won't get in the way of getting going with NEO. You set this 
option on the Tools | Options menu. Fast sync (on startup) will ensure NEO is updated with 
new, changed (filed) and deleted messages while you are using Outlook. 

Full sync will be needed when you delete messages when NEO is not running. You'll know 
this because you'll see a message in NEO that is listed but whose contents can't be 
displayed.. 

In summary, if you keep NEO running while using Outlook and you Fast Sync on startup, 
you'll always stay in sync. 

How to synchronize manually 

On the toolbar are three buttons for manually synchronizing: 
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In the lower-right status bar progress of the synchronization is shown. From there you can 
also cancel it at any time. 

Choosing message stores to keep synchronized 

Click Sync on the standard toolbar to control how you want to synchronize (Fast sync or Full 
sync), and to choose what message stores you want to synchronize. 

The messages stores checked at the top of the dialog are the ones that are synchronized 
when you perform a Full or Fast sync. You may want to consider not synchronizing older 
messages stores that you only use for reference purposes and are not changing in content 
anymore. 

Messages for message stores you choose not the synchronize will still remain in your catalog 
- they just won't be updated if the messages are edited or deleted, or new messages are put 
into them.      
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Catalogs 

Catalog Overview 

NEO works by creating indexes to your messages and storing them in a separate database 
called the catalog. Your messages are not stored in the catalog, just references to them. 

Whenever messages are sent, received or updated in a message store, NEO automatically 
updates the indexes in the catalog. 

Your first catalog 

A catalog is created by a Catalog Setup wizard when you start NEO for the first time, and 
whenever NEO is opened with a new mail profile. The catalog is created in several steps. 
The more messages you have the longer it will take to create your catalog, however catalog 
creation is only performed once. 

All your message stores can be included in NEO’s catalog to provide a seamless 
organization of all your messages independent of their location within Outlook. Also IMAP 
message stores can be added.  

Multiple catalogs 

Users can have more than one catalog. It is even possible to open multiple copies of NEO 
using different catalogs.  

All messages from all messages stores in a catalog are unified - that is, organized together in 
the same Correspondent folder and in results of a Search. If you want to keep message 
stores separate then you can create separate catalogs for them.  

Catalog Basics 

Opening and Closing a Catalog 

Open and close catalogs using the File menu: 

           

Opening a catalog 

You can: 
1. Pick from the most recent used list. 
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2. Click Catalog then click Open Catalog: 

     

When the dialog opens you see the catalogs you have created for your current mail profile. 
You can choose to open up a catalog from another profile by selecting the option at the top. 

Automatic catalog opening 

By default, the last catalog you opened is automatically opened for you next time you start 
NEO. If you don't want automatic opening to occur, you can: 

1. Disable the option. See Tools menu | Options General tab. 

2. Override the automatic open option by pressing the Shift key when clicking your NEO or NEO Pro 
desktop shortcut (keep Shift down until NEO is fully open). 

Closing a catalog 

You can: 
1. Choose Close Catalog from the File menu. 

2. Open a different catalog. 

Your Message Stores 

  

Message stores defined 

Message stores are repositories of messages and Outlook items. In Outlook, they are in your 
Folder List and look like this (in collapsed mode): 
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In NEO these same message stores appear in the NEO's Outlook view. There are five 
message stores types that NEO organizes: 

Exchange 
Mailbox 

If you use Exchange Server, this is typically where your 
messages are delivered. This message store is your Mailbox 
which is where your email data is stored on your company's 
server computer. 

Exchange 
Delegate 
Mailbox 

You can delegate access of your Exchange Mailbox to others. 
When you do, it appears in their Folder List just as though it is 
theirs. This message store is located on your company's 
server.  

Personal 
Folder 
(PST)

 

Sometimes known as PSTs, Personal Folders, or Data Files, 
these are typically stored on your own computer. You create 
these in Outlook to improve Outlook performance. 

Offline 
Folder 
(OST) 

These are special Exchange user variants of Exchange 
Mailboxes that contain messages you have designated to 
synchronize for offline use. These are automatically handled 
by NEO when you are in offline mode. Cached Exchange 
Mode in Outlook 2003 and later makes extensive use of 
Offline Folder files. 

IMAP 
folders 

When adding an IMAP email account (such as Gmail) to your 
Outlook system, you will find the online IMAP folders in your 
Outlook Folder list. These can be organized in your NEO 
catalog. 

Moving or closing your Outlook message store (Personal Folder, PST) 

If you move an Outlook message store that is organized in NEO, Outlook changes its internal 
identifier. When you next start NEO, NEO will then not be able to find it. To make it visible 
within NEO again you will need to remove it and re-add it (see next section).  

If you close an Outlook message store in Outlook you will need to remove it from NEO too 
(again, see next section).  

Adding and removing message stores 

You can only add message stores that are in your current mail profile.  

Note:    If you change the message stores that are in your Outlook profile, you must 
restart NEO (the message stores available to NEO are only determined when 
NEO starts). 

You explicitly add or remove messages stores via Catalog Properties by clicking File menu | 
Message Stores, or when you create a catalog. 

Here is the how you choose catalogs when creating a catalog: 
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Check the message stores you want included, and uncheck those not to include in NEO. You 
can add or remove message stores from your catalog at any time. 

You don't need to add/remove offline message stores explicitly. When you go offline in 
Outlook, with or without Cached Exchange Mode, NEO will automatically organize your 
offline store. 

You can choose from message stores in your mail profile. If you want to include message 
stores not in your profile, you must add them to your profile first. 

Set a time limit for older messages in the Catalog 

You can keep older messages out of NEO’s catalog by setting a time limit within the 
Miscellaneous tab under View | Options.  

           

Messages older than the selected date will be excluded from NEO’s catalog independent 
how or where they are organized within the Outlook system. 

Changing this date will force a full synchronization and update of the word index. 

Catalog Properties 

Use Catalog Properties to review information about a catalog, and to add/remove message 
stores from a catalog. 
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General tab   

Shows the name, size and location (folder the catalog files are stored in). The name of a 
catalog can be different than the location folder name.  

Messages Stores tab   
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Message stores that are delegated into another Exchange Server's Mailbox must be alone in 
their own catalog. 

Creating and Deleting Catalogs 

Creating a New Catalog 

You create catalogs using the New Catalog wizard. Click File menu | Catalogs | New Catalog 
to start it. The New Catalog wizard also starts automatically the first time you run NEO, or 
when you open a mail profile that you haven't yet created a catalog for. 

The New Catalog wizard consists of six easy steps. You can cancel or go back and edit your 
settings at any time - catalog creation doesn't start until the final step. 

Step 1 
Choose a name    

The name must be unique across your catalogs. 
Default name for 1st catalog is “Email Catalog”. 

Step 2 
Choose 
location 

The default location for your catalog is the same 
general area of your Application Data into which your 
Outlook personal folders are stored. You can put it 
wherever you like but it should be in a location where 
there is lots of disk space available. 

You can choose a network drive but keep in mind that 
your performance will be affected if on a slow drive. 
It's fastest to store it on your local computer. Note that 
by default, like Outlook, the catalog is stored in the 
non-roaming section of your computer. 

Step 3 
Select your 
message stores 

Users can include more than one message store in a 
catalog. 

Normally you would select all message stores for a 
seamless organization of all your messages. 

Step 4 
Identify your 
spam folders 

Identify if you have folders that capture Spam (junk 
mail). Microsoft Outlook and many spam-detection 
programs automatically funnel spam-looking 
messages to Outlook folders. 

Messages contained in the spam folders you 
designate are not included in NEO. You can change 
this at any time within NEO. 

Step 5 
Verify your 
email 
addresses 

NEO needs to know which email addresses are 
yours. Note that NEO needs to know all your 
addresses - even ones you don't use any more.  
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NEO attempts to determine your addresses 
automatically. Add to or remove from this list. 

Step 6 
Start 
synchronization 

Now that all the information is collected, click Next to 
start the synchronization process. A progress dialog 
will appear.   

Deleting a Catalog 

When you delete a catalog only the NEO information is deleted. Your messages will remain. 
1. Click File menu | Catalog | Delete Catalog. 

2. Choose catalog to delete. You can select a catalog from your current profile or all profiles. If you 
do not see your catalog in any profiles, click Browse to locate it. 

       

Catalog Maintenance  

Rebuilding a Catalog 

Sometimes it's necessary to rebuild your catalog, for example when one of your database 
records gets corrupted after a power failure. Note that you should always shut NEO down 
normally to help prevent errors such as these. 

It is normally not necessary to rebuild your catalog to improve performance. You should only 
need to do it when advised to.  
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The rebuild process completely rebuilds your catalog from your messages. All your folder 
names and settings will be preserved. Rebuilding your catalog can take almost as long as it 
took to create your catalog in the first place.  

You can choose to build the current catalog or choose another catalog.  

       

Restoring a Catalog from Backup 

You can use the Restore from Backup feature to overcome a data problem with your catalog.  

As a safety precaution, NEO backs up critical catalog files to a folder called Backup in your 
catalog folder. The Restore from Backup feature uses these critical files to completely rebuild 
your catalog from the saved files. 

To restore your data: 
1. Click File menu | Catalog | Restore from Backup. 

2. Choose catalog to restore.  
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Backing up and restoring the catalog 

The catalog contains information about your messages and your Correspondent folders. 
Even though you could always recreate your catalog from scratch if it got corrupted, you 
would lose the customizations you have made. 

NEO automatically backs up key data files 

At least every three days NEO backs up key data files to a folder called Backup in your 
catalog folder. From these key files, your catalog can be completely rebuilt without any 
information loss. 

You can use Restore from Backup (File menu | Catalogs menu) to restore and rebuild your 
catalog. It will automatically use these previously saved files. 

Backing up the catalog manually 

While the above offers some protection in restoring to correct data corruptions, it offers no 
protection against accidental deletions, hardware failures, and the like. 

You may wish to back up the catalog manually to an external location. You can choose to 
simply back up the key data files from your catalog folder(s), or you can choose to back up 
all the files from your catalog folders. If you choose just the key data files you will need to 
also then perform a catalog rebuild operation after restored, whereas if you back up all the 
files in your catalog a catalog rebuild is not necessary. 

There are three key files to back up. The current versions exist in your catalog folder, and 
older backup versions exist in the Backup subfolder. The files are: 

 

CatalogConfig.xml 
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NAD.dat 

 
NFL.dat 

Restoring the catalog from a manual backup 
1. Close NEO. 

2. Restore the files you backed up to your NEO catalog location. 

3. If you restored just the two key data files, you must also do a catalog rebuild.  

Locating and moving the catalog 

Where the catalog is stored 

The catalog is automatically created for you and stored in a folder of your choosing. To find 
where the current catalog is stored, view the catalog properties. Click File menu | Catalog | 
Catalog Properties. 

A quick way to locate where your default catalog location is to start creating a new catalog 
(click File menu | Catalog | New Catalog) then click through the first panel and you will see 
the default location. You can also browse from there. You can click Cancel to stop the New 
Catalog wizard. 

To find all your catalogs on your computer, you could also do a Windows Search and search 
for all occurrences of file CatalogConfig.xml.  

Moving the catalog 

There is no command within NEO to move the catalog. However, if you wish to move it you 
can do so using these steps: 

1. Close NEO. 

2. Locate the catalog you want to move (see above). 

3. Move the entire catalog folder and subfolders to your new location (it must not exist in the original 
location – if you copy it, delete it from the original location). 

4. Start NEO. You will be notified that the catalog files are missing.  

5. Click File menu | Catalogs | Open Catalog. Select the catalog you want to open in the list then 
click Browse. Browse to your new location and select the file CatalogConfig.xml.   
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Buying, Registering, Updating, 
Uninstalling 

How to buy NEO Find 

All information about purchasing NEO Find is contained in our online store. 

http://www.emailorganizer.com/store/index.php

  

How to register your license 

Your license 

Registering your license simply means entering your License Code and License Key into 
NEO so that we can enable your product for permanent use. We don't collect any personal 
information other than the code and key (unless you provide it to us in our opt-in form).  

When you first start NEO Find we automatically issue an Evaluation License to you that is 
valid for the evaluation period. When the evaluation period is over you won't be able to 
continue to use NEO Find until you receive a permanent License.  

When you purchase NEO Find you will be sent an email containing your License Code and a 
License Key. These two components work together. If you change any part of either one, you 
won’t be registered. 

Entering your license information 
1. Click License on the Help menu.  

2. Enter your License Code and License Key exactly as provided to you, including upper and 
lower case. You may find it easiest to copy and paste it from the email we sent you. 

3. Click Activate.  If invalid, check the email message you received it on and try it again. 

Important: NEO licenses are valid for minor version upgrades only (1.1, 1.2, …). For a major version 
upgrade (from 1.x to 2.x) the license can be upgraded – for licensed users we will provide reduced 
upgrade pricing. Click "Get Evaluation License" to try a new major version free during the evaluation 
period. 

4. Click OK. 

Please Note: Individual licenses can only be activated on a single system. Site Licenses can be 
activated for the number of computers the license was issued for (e.g. a site license with 100 seats 
can be activated on 100 systems). 

Transferring your license to another computer 
Before you can use your license on another computer, the license first needs to be deactivated on the 
initial system: 

1. On the original system click License on the Help menu.  

2. Click Deactivate. Note your license code and key to transfer to your other system. 

3. On the other system, repeat the initial steps of entering license information as outlined above. 

http://www.emailorganizer.com/store/index.php
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Failing to deactivate the license as described here will invalidate the license in which case a new 
license needs to be purchased. 

Reinstalling NEO on an existing system 
The license activation process links the license to a unique, encrypted hardware hash of the system in 
use. Reloading the entire software (or even reformatting the drive) is not affecting license activation 
when NEO Find is reinstalled. Also the activation process is designed to handle routine hardware 
upgrades on the same system. 

Checking for product updates 

NEO will automatically check for product updates when you start NEO if you have the option 
checked on the Tools | Options | General tab. 

To manually check whether an updated version of NEO is available: 
1. Click the Help menu. 

2. Click Check for Updates (online). 

This operation compares your version with the latest version available by connecting to our 
website. You will be told whether or not a new version is available. 

Determining Your NEO Version 

To determine your NEO version: 
1. Click the Help menu. 

2. Clicking About NEO Find. 

Uninstalling NEO 

To uninstall NEO: 

1. Click Start, then Control Panel then Add/Remove Programs program. 

2. Select NEO Find. 

3. Click either Change or Remove (depends on your system). If you clicked Change, then 
choose Remove when the dialog appears. 

PLEASE NOTE: When you intend to use your license on another machine, please FIRST 
deactivate your license from Help | License BEFORE uninstalling.  

4. You can choose whether or not to remove your catalog data. If you believe you will not 
be using NEO again, then choose to remove it. 

5. Also, it helps us to know why you are uninstalling NEO. We'd appreciate it to click 
the box to give us a reason if prompted.   
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Common Questions   

If you don't find the answer to your question here, please click Support (online) on the Help 
menu. For downloading, installing or licensing questions, see next section. 

Using NEO Find 

What's the best way to start NEO? 

Enable the option to automatically start NEO when Outlook starts, and start Outlook in 
your normal way. 

Does NEO store copies of Outlook messages? 

No. NEO stores indexes (shortcuts) to your Outlook messages. However, if you create a 
message in NEO the message will appear in your Outlook message folder. Similarly if you 
delete a message in NEO it will be deleted in Outlook. You can also move messages 
between Outlook folders from within NEO and the move takes place within Outlook.  

Does NEO work with all parts of Outlook? 

NEO only organizes your email contained within Outlook Please note that NEO does not 
integrate with Outlook’s Public Folders (in Exchange). 

Does NEO work with IMAP message stores included in Outlook? 

Yes, NEO Find can also organize all messages included in the IMAP message store as 
visible in Outlook. 

When a message is moved within Outlook it doesn’t appear to move within NEO 

Messages in NEO appear in more than one place at the same time, and the folders are 
created automatically for you. These NEO folders are virtual folders showing your 
messages independent of their location within Outlook. When a message is moved within 
Outlook, it will still appear under the same Correspondent Folder – in NEO’s preview pane 
the folder location can be seen which shows the updated information. 

How do I exclude Spam/Junk Folder messages from showing in NEO? 

You can designate Outlook folders to be excluded from NEO's Correspondent folders. You 
choose your spam folders when you create a catalog, but you can also specify that setting 
as a Folder Property for any Outlook user-defined folder (right-click the folder and choose 
Folder Properties). 

Search didn't find a message it should have 

The most likely reason is that it was a very recent message. Like the web, NEO makes 
searches fast by indexing words in the messages. However, it only does this at certain 
times - the default is every 30 minutes. You can change how often NEO does a word index 
by going to Tools | Options | General Tab. 

How do I exclude Deleted Items and Excluded folders from my search? 

In the Search window, click the blue/white arrow next to the Folder box. From the selection 
screen select “All except Excluded and Deleted Items“. 
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How do I hide Sent mail from NEO folders? 

All NEO folders automatically display both sent and received mail.You can use the 
Direction filters on the Filter toolbar to show Sent, Received or both types of mail. 

How do I add a message store? 

You can organize more than one message store in your catalog. To add another message 
store (or change what message stores are included in your current catalog), click File 
menu | Message Stores. Note that a message store must be in your current profile (i.e., 
visible in your Outlook Folder List) to be able to add it to your catalog. Also, note that you 
must restart NEO after adding new messages stores in Outlook so that NEO can see 
them. 

How do I copy a message? 

Right-click-drag the message or messages from the List Pane to the folder you want to 
copy it/them to. When you release the mouse button, you will be given the choice to copy 
or move. 

How do I stop connecting to the Internet in the Reading Pane? 

Like Outlook, when an HTML message in the Reading Pane needs an object from the 
Internet, it automatically goes and gets it (subject to your Connection tab option settings in 
Internet Explorer). You can prevent NEO from getting those images (regardless of other 
settings) by setting this option in Tools | Options | Reading Pane tab. 

What Outlook folder is my message in? 

Look on the Reading Pane header. The Outlook folder where the message is stored in, is 
labeled Folder. 

Or press Ctrl+J (Jump to Folder) to see where a message is organized; from here you can 
easily jump to the containing Outlook folder. 

I get a startup message about my default email program 

For some versions of Outlook, NEO requires that Microsoft Outlook be configured as your 
default email program. NEO detects this and reports it to you each time you start NEO. 
Ensure "Microsoft Outlook" is your default email program. To change the setting: click 
Start, point to Settings, click Control Panel, then double-clicking the Internet Options icon. 
Click the Programs tab, then choose Microsoft Outlook as the E-mail program. Do not 
choose Outlook Express.. 

It could be that NEO will work well for you even if you get this message. If  NEO does work 
for you, you can disable the message by adding the following key in your registry. 

For NEO Find add this one: 

   HKEY_CURRENT_USER\Software\Caelo\NEO Find\1.0\Options\NoDefaultClientCheck 

as a Dword value set to 1.  This will disable checking on startup. You should be very 
careful when modifying your registry. If you have any questions, please send an email to 
support@caelo.com. 

Why can’t I see my attachment? 
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If you have the Microsoft E-mail Security Update installed you will not be able to open or 
save certain file types. Please consult your Microsoft Outlook documentation for more 
information. 

Some messages appear incorrectly addressed to or from me 

Have a look at your addresses. If not all your addresses are in there, your email will not 
show correctly. 

NEO doesn’t start properly 

NEO will not start and will report errors if email is improperly configured on your computer.  

Some startup problems can also occur because of interaction with other email-aware 
programs you may be running. We can help solve these conflicts. Please contact us. 

How often should I synchronize? 

When you let NEO start together with Outlook and have NEO configured to Fast Sync on 
startup, there is no need to manually synchronize NEO. You can set both options on Tools 
| Options. 

How does the NEO Sync differ from Outlook Synchronize? 

NEO Sync synchronizes your message store (Exchange mailbox, PST or OST) with the 
NEO catalog (where NEO stores all of its data). 

Outlook Synchronize applies only to Exchange users who have enabled offline access. It 
synchronizes your Exchange mailbox with your offline message store (OST). It is not 
related to NEO's synchronize. 

How do I back up my NEO data?  

NEO automatically backs up critical files for you, and you can backup those catalog files 
manually too. See chapter on Catalogs for more information. 

How do I report a problem? 

Click 'Send Email to Support' on NEO's Help menu. 

Downloading, Installing, Licensing ... 

Is the trial version of NEO Find different from the "final" version? 

No. In fact the trial version is the final version. When you purchase NEO Find we send you 
registration information that you enter into NEO. Simply by entering the registration 
information, the trial period is removed and you're all set. 

Do I have to re-download on purchase? 

No. All you need to do is enter the registration information that we email to you. To enter 
this information go to Help | License. 

How often can I download? 

As often as you like.  

What NEO Find upgrades do I get for free? 

If you are an unlicensed user you are entitled to download and try out any version of NEO 
provided your trial period has not expired. 
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If you are a licensed user you are entitled to all versions of the same major version level. 
For example, if you purchased version 1.0, you are entitled to free upgrades for all 1.x 
versions (e.g. 1.1, 1.2, etc.). 

How do I know I have the latest version? 

Select Help | Check for Updates 

How do I permanently register NEO Find? 

When you purchase NEO you will be sent registration information and instructions on how 
to register. 

Am I sent the "final" version? 

No we don't send anything except the registration information. The trial version actually is 
the final version. Simply by entering the registration information, the trial period is removed 
and you're all set. 

Do I have to re-register when I upgrade NEO? 

You'll automatically stay licensed if you are upgrading the same major version (e.g., 1.0 to 
1.1).  

If you are upgrading to a new major release (for which we offer an upgrade price), you will 
need to enter new registration information. For a new major version a new evaluation 
license can be obtained to freely test the new version before deciding to upgrade. 

Will I stay licensed if I upgrade my computer? 

See “Buying, Registering and Updating” for more information. 

What if I lose my registration information? 

Connect to our support page online and click the link "Resend License Information".  

Is NEO easy to uninstall? 

Yes. Outlook settings are never changed and all your messages are left intact. By the way, 
Outlook always continues to get messages whether you are using NEO or not. See topic 
"Uninstalling NEO".   
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Reference 

Keyboard shortcuts 

  

Find Messages 
F5 Find Correspondent 
F6 Search in (Correspondent) Folder 
F7 Search on Conversation 
F8 New Search 
Ctrl+J Jump to Folder 

Switching Views within NEO 
Alt+C Switch to Correspondent view 
Alt+O Switch to Outlook view 
Alt+S Switch to Search view 

Message Actions 
Ctrl+O or Enter Open Message 
Ctrl+R Reply 
Ctrl+Shift+R Reply to All 
Ctrl+F Forward 

Folder List 
F2 Rename folder 
Num + Expand current folder in Folder List 
Num - Collapse current folder in Folder List 
Ctrl+Shift+Num + Expand all folders from anywhere in list 
Ctrl+Shift+Num - Collapse all folders from anywhere in list 

Switching to Outlook 
Ctrl+0 Switch to Outlook current location 
Ctrl+1 Switch to Outlook Inbox 
Ctrl+2 Switch to Outlook Calendar 
Ctrl+3 Switch to Outlook Contacts 
Ctrl+4 Switch to Outlook Tasks 
Ctrl+5 Switch to Outlook Notes 
Ctrl+8 Switch to Outlook Journal 

Working with the List and Reading Pane 
Ctrl + Up or Ctrl + Move to previous message  
Ctrl + Down or Ctrl + Move to next message 
Ctrl+Shift +Alt Up/Down Scroll List Pane without changing focus 
Ctrl+Home To first message or start of message 
Ctrl+End To last message or end of message  

Ctrl+Alt+Up Reading Pane On 
Ctrl+Alt+Down Minimize Reading Pane 
Ctrl+Shift+Up Increase Reading Pane 
Ctrl+Shift+Down Decrease Reading Pane 
Ctrl+Shift+PageUp Maximize Reading Pane 
Ctrl+Shift+PageDown Restore Reading Pane 
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Launching weblinks 
Click link Launch weblink in current browser window 
Shift+Click link Launch weblink in new browser window 

Actions generally available anywhere 
F1 Help 
F3 Filter folder names of current view 
Ctrl+L Toggle filter on/off 
Ctrl+Shift+L Clear filter 
Tab Cycle panes forward (View, List, Preview)  
Shift+Tab Cycle panes backward 
Alt+Left Back to previous folder 
Alt+Right Forward to next folder 
Shift+ Start NEO Starts NEO without opening a catalog 
Ctrl+Shift+ Start NEO Starts NEO and resets Workspace and Toolbar back to default     
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Symbols 

Message status symbols  

High Importance (otherwise blank)  

Filed to folder other than Inbox or Sent Items (otherwise blank)  

Unread  (Read messages show as blank)  

Message has been replied to  

Message has been forwarded  

New or draft  

Waiting to be sent (in Outbox)  

Flagged - Colored (plus 5 other colors)  

Flagged - Complete  

Attachment  

Sent message (otherwise blank)  

Digitally signed - Valid  

Digitally signed - Invalid  

Meeting Request - Sent  

Meeting Request - Declined  

Meeting Request - Accepted  

Meeting Request - Tentatively Accepted  

Task Request - Sent  

Task Request - Accepted  

Task Request - Declined  

Delivery Report - Read  

Delivery Report - Non-read  

Delivery Report - Delivery  

Delivery Report - Non-delivery  

Delivery Report - Other  

Message Recall - Success  

Message Recall - Failure     

NEO Folder symbols  

Correspondent  

Saved Search 
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Outlook view Folder symbols  

User folder  

Inbox  

Outbox  

Sent Items  

Deleted Items  

Drafts  

Junk E-mail  

Contacts  

Non-email (Calendar, Journal, Notes, Tasks)     

Filter symbols  

Filter folders with Unread messages   

Filter Unread messages  

Filter Not Filed messages  

Filter Flagged messages  

Filter received messages  

Filter sent messages   

Date filter From… To… 

Toolbar (command) symbols  

Reply to message  

Reply to All addressees  

Forward message  

Fast synchronization  

Full synchronization  

Open Outlook  

Find Correspondent  

Search in Folder  

Search for Conversation  

New Search 

 

Jump to Folder  

Back to previous folder  

Forward to next folder 
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Other symbols  

Help  

Catalog  

Folder Properties  

Search - Update word index  

Search - Save current search  

Search - Choose search folder   

Folder List Filter - Tree order   

Folder List Filter - Alphabetical order   

Folder List Filter - Recently-used order  

Previous message  

Next message 

Privacy Policy 

Click http://www.emailorganizer.com/aboutus/privacy.php

 

to browse to our Privacy Policy. 

Trademark Notices 

©  Copyright 2008 by Caelo Software B.V..  All rights reserved  
de Vlasakker 4  5555 LH Valkenswaard  Netherlands 

Caelo, NEO, NEO Find and Nelson Email Organizer are trademarks of Caelo Software 
B.V. 

Microsoft, Outlook, Exchange, Outlook Express and Windows are either registered 
trademarks or trademarks of Microsoft Corporation in the United States and/or other 
countries.  

http://www.emailorganizer.com/aboutus/privacy.php

